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Using PrintEnvelope

PrintEnvelope is designed to print any-size envelope, labels or flyers on your Windows
supported printer.    PrintEnvelope gives you access to your printer fonts, font 
sizes ,attributes and graphic bitmaps.    When printing envelopes, there is no need to 
manually change your printer's orientation or to do a Printer Setup on most printers.    The 
program is written in Microsoft's Visual Basic and requires Windows Version 3.x and the 
Visual Basic runtime VBRUN300.DLL.    If you do not have a copy of the runtime DLL, it may 
be downloaded from CompuServe (MSBASIC forum, library 5) or most other BBS systems.    
Look for VBRUN3.ZIP.    You may also acquire a copy of the DLL by request from the author 
upon registration.    

Installation

Default Settings

Printer Driver

Calling from Word Processors



Return Address
PrintEnvelope allows you to create new return addresses or to select previously created and
saved ones.    You may also choose to use a graphic logo with your selected return address, 
a graphic in lieu of a text return address or no return address at all.    Select from the 
Return Address menu your choice of the return address and graphic to be printed on the 
envelope or label.

When printing labels, the return address text, logo and note text, if present, print together 
only on the 3 1/3 x 4 inch labels.    If the addressee text box is empty, the return address 
text, together with the return address graphic, if present, will print on the labels.    If there is
addressee text, only the addressee text prints on smaller sized labels.

Entering or Modifying a Text Return Address

Using Graphics in the Return Address

Positioning the Return Address



Printer Fonts
The Selected size options... button of the Document menu allows for the selection of 
printer fonts, sizes, and attributes for the return address, addressee text and note text, 
individually.    

First, select which element you want to change: return address, addressee or note text.    
Notice that each of these sections is displayed WYSIWYG, in the font, size and attribute to 
be used in printing.    This lets you preview your changes as they are made.    If you select a 
printer font for which there is no screen font, the selected font will be used for printing but 
may not display correctly.

Make your changes, then when finished with all elements, choose one of the following 
options:

Cancel       Cancels changes made and restores default settings.
Save       Use changes and save as default settings for the selected document size. 

Positioning Printed Text  



Envelope & Label Sizes
Choose the envelope or label size you wish to print on by clicking Document .    Select from
the drop down combo box the envelope, label or flyer you wish to print on.    If the envelope
or label size you desire is not listed, choose Other Size and enter the envelope, label or 
post card dimensions in either inches or millimeters.    The size you enter is saved for future
sessions and can be changed at any time.

Labels are designed to print on Avery® Laser Printer Labels or similar sized labels or on 
continuous pin feed forms.    If printing laser sheet feed labels, select the label size, starting
position and number of labels desired.    The starting position can be set to print on a 
partially used sheet of laser labels.    On two-across labels, the top row left label is position 
#1, top row right is position #2, second row left is position #3, etc.    To print different 
addresses on the same label sheet and then print the sheet when finished, check 
Accumulate Labels.    When accumulating labels, the labels will print automatically when 
the sheet is full, or, you can click the Print Labels in Buffer button when ready to print 
the sheet.    If printing with on a dot-matrix printer to continuous labels, select the label 
size, the number of labels across and the number of labels desired.

Return Address text, logos and note text, if any, only prints on the 3 1/3 x 4 inch labels.    If 
the addressee text box is empty, then the return address text together with a return 
address graphic, if present, will print on the labels.    Only the addressee text prints on 
smaller sized labels if there is text in the addressee text box.

Positioning Printed Text



Address Book
Select your often-used addresses to paste into PrintEnvelope by using the Address Book 
feature.    Initially, Windows Cardfile is the default Address Book.    The default may    be 
changed to use your favorite PIM.

To change your Address Book, select the Change Book FileSpec menu option.    Enter the 
path and filename of the program you wish to use or use the file dialogs to find the 
program.        

Select Open Book to access your address files and select the desired address record.    
Copy the address text to the envelope by clicking the Paste card button which appears on 
the bottom of the envelope when the address book is opened.    Many programs also allow 
you to copy selected text by clicking the Edit menu and choosing Copy.    The address can 
then be pasted into the envelope by clicking the Paste button.    Using this technique, you 
can leave your address book open to copy another address for additional envelopes.

Importing a Mail List



Registration
PrintEnvelope is user-supported software provided to you at no charge on a trial basis.    If 
you use the software beyond a reasonable evaluation period (45 days) and find it of value, 
please send $29.00 for a registered copy and support the shareware concept.    Usage of 
the program beyond the evaluation period is not authorized.    Registered users receive the 
most current version on disk, are provided with information about program updates, receive
bonus programs, a 46000+ city/state database of ZIP codes and are entitled to user 
support .

You can register directly from Maurer Associates with payment by check or company 
purchase order.    To do so, run PrintEnvelope, Click Help, select About and choose 
Register.
You may also order from the Public Software Library, PO Box 35705, Houston TX    77235-
5705, with your MC, Visa, AmEx or Discover Card by calling 800-242-4775 (from overseas: 
713-524-6394) or by FAX to 713-524-6398 or by CompuServe to 71355,470.    Ask for 
product number 10442, PrintEnvelope.    These numbers are for ordering only. For 
Information about volume discounts, site licensing, the status of shipment of the product, 
the latest version number or for technical information call (214)432-0700.
In France, you may place your order through our agent, WindowShare SARL by calling 
(+33)87 30 85 57 or by Fax: (+33)87 32 37 75 or by Minitel: 3615 WinShare.

PrintEnvelope is produced by a member of the Association of Shareware Professionals 
(ASP).    ASP wants to make sure that the shareware principle works for you.    If you are 
unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help.    The ASP Ombudsman can help you resolve a 
dispute or problem with an ASP member, but does not provide technical support for 
members' products.    Please write to the ASP Ombudsman at 545 Grover Road, Musegon, 
MI 49442-9427 or FAX to (616)788-2765 or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536.

You are encouraged to share the shareware evaluation copy of this software with others, 
and/or to post it to bulletin boards, provided that it is distributed complete with 
documentation and in unmodified form and that no fee or other consideration is charged or 
accepted.    You may not distribute the registered copy of PrintEnvelope or your license 
number to others.

All commercial, business and government users must register each copy in use.    Please 
contact us for multiple copy or site license terms.

The Warranty



Envelope Feed Options
PrintEnvelope is designed to print on a wide variety of laser, postscript and dot matrix 
printers.    To make feed selections, Choose Envelope Feed from the Options menu.

Select Paper Source to tell PrintEnvelope where to find the envelope to print on.    The 
choices presented are the various paper bins supported by Windows and your Printer 
Driver.    Your printer may not have all of the listed bins installed.    First, print using the 
Default menu choice.    If your envelope does not feed correctly, experimentation with the 
various bin choices should produce the desired results.

If your laser printer has a variable size center feed, select Center; otherwise select either 
Right or Left as the feed direction depending on which side of the printer you feed an 
envelope.    Dot matrix users should choose the Left option.    Normally, if using a laser 
printer and selecting other than Default Paper Source select Side Feed (Left) even if 
your printer has a center feed slot.

If your Return Address text prints too far to the left (by approximately 1½ inch) select the 
Shift Right check box.

The Feed options selected have no effect when printing labels.    Label sheets may be 
placed in the default paper tray, tractor feed or feed manually.

Feed selections for some popular printers (dependent upon the printer driver installed) are:
Printer Feed Shift Right Paper Source
Brother HL-8 center               X      default
Cannon Bubble Jets left       default
HP DeskJet 500 ** left               env-manual *Portrait
HP DeskJet 520 & up left                env-autofeeder *Landscape
HPIIP or IIIP left                      X      default
HPIIP (lower tray inst) left                      X      upper
HPII center               X      default
HP4 (w/MP tray) left                      X      upper
IBM4019 left                env-manual
IBM4019 (w/envelope) left                env-autofeeder
Okidata 810 center               X      default
Panasonic KX-P2124 center               X      default
Most Dot Matrix left                default *Portrait

** HP DeskJet 500 note:    Place the envelope in the feed slot but DO NOT advance it into 
the printer via the two feed buttons.



Installation

PrintEnvelope and the PrintEnvelope Setup program require Microsoft's Visual Basic runtime 
VBRUN300.DLL.    This file is provided on the PrintEnvelope Install Disk #1 and will be 
properly installed for you.    If you acquired this copy of PrintEnvelope from a BBS, then the 
file is not included (to save space) and must be present in your WINDOWS\SYSTEM directory 
before running Setup.    You can find VBRUN300.DLL on most BBSs, look for VBRUN3.ZIP or 
call Maurer Associates for assistance in locating the file.
1.    If Windows in not already running, Type WIN at the DOS command prompt.
2.    Insert the PrintEnvelope Install Disk #1 in your computer's floppy disk drive.
3.    Double-click the Windows Program Manager, if it is not already open.
4.    From the Program Manager's File menu, choose Run.
5.    In the Run window, click in the Command Line box.    Now type a:setup if you are 
installing from drive A, or type b:setup if you are installing from Drive B.    (The setup 
program may also be run from a sub-directory on your hard disk if desired.)
6.    Click OK to continue and the PrintEnvelope Setup window will appear.
7.    Setup will create a Program Manager Group and install the PrintEnvelope in the new 
Group.    After installation, you may move the program icon to another group and delete the 
PrintEnvelope group if you desire.    If you are not using Program Manager as your desktop 
shell, the PrintEnvelope setup program may not have been able to create the new Program 
Manager group and copy the PrintEnvelope icon.    DDE is required for this operation and 
many replacement shells do not support DDE.    If this is the case, install the icon to your 
desktop using your shells directions or run the Program Manager and follow the following 
directions:
Install PrintEnvelope in the program group of your choice by:
1.    Open the Program Group you wish to install PrintEnvelope into.
2.    Select FILE in the Program Manager and choose NEW.
3.    Click OK to select Program Item.
4.    In the Description box enter: Envelope and press the Tab key.
5.    In the Command Line box, enter the full path name of the PrintEnvelope directory 
followed by \ENVELOPE.EXE.
6.    Click OK to complete the installation.
Special note for Network users:
If running on a network, the Setup program will not work properly in copying files to Network
Drives.    First copy the PrintEnvelope files to a Local Drive and then copy to the Net Drive.



DoubleClick
Click the left mouse button twice in rapid succession.



Default Settings
Initially, PrintEnvelope default settings do not exist.    As you use the program and enter 
return address information and select various menu options, PrintEnvelope will create an 
initialization file named ENVELOPE.INI in your Windows directory.

To save the current configuration of PrintEnvelope as the default, click File and select Save
configuration.    Changes in your configuration may also be saved automatically when you
exit the program.    Click Options and select General... to set the way changes are made 
to your ENVELOPE.INI file when you exit the program.



Printer Drivers
For PrintEnvelope to work automatically and without the need to do a Printer Setup, your 
Windows Printer Driver should be current and have been written for Windows Ver. 3.x.    
PrintEnvelope sends the codes necessary for landscape printing and paper bin selection via
the Printer Driver so that the user does not need to do a Printer Setup or manually change 
the printers orientation.

If, when using PrintEnvelope, you do not get expected results, check to see that you have 
the latest version of the printer manufactures Windows Printer Driver.

Printer drivers are constantly being updated.    If you are running Windows version 3.0, 
the most current driver for your printer may be necessary to use PrintEnvelope without 
doing a Printer Setup through the Control Panel.

The option, Printer Setup in the File menu, allows you to call for the printer setup 
window.    Use this option only if your printer driver will not work with PrintEnvelope to 
change the paper bin or orientation.



Word Processors
You can use PrintEnvelope from your word processor in three ways:
1)    By selecting the Control Box and choosing Run.    Enter the command    ENVELOPE.EXE 
and click OK.    

2)    If PrintEnvelope is running as an icon. call the Task Manager by pressing the Ctrl and    
Esc keys simultaneously.    Select PrintEnvelope from the task list.

3)    You can also automate printing envelopes from Word for Windows (or other word 
processors) by creating a macro to run after printing a letter.    

A complete Word for Windows (version 2.0) macro is included as PE-MACRO.DOC as an 
example:

You can further automate printing envelopes with command line switches or when the 
envelope appears on the screen, Click the Paste button to copy the addressee information 
into the envelope.

Command Line Switches



Entering or Modifying Return Addresses
Up to six permanent return addresses can be entered, named with a caption that is used in 
the Return Address menu, and saved for easy re-use.

To enter new return address data, or change data displayed, Choose Edit Return Address
from the Return Address menu.    Enter your new return address information, or make 
changes to the displayed return address text.

To Save the modified or new return address, choose one of the four menu # positions you 
want the return address to occupy in the Return Address menu. Give the return address a
"Save as" menu caption name such as Home, Office, etc.    This short name now appears in 
the Return Address menu as a selection for the return address information you have 
entered.    The next time you run PrintEnvelope, the menu caption name appears in the 
Return Address menu and when selected, displays your return address information on the
envelope.

Choose Cancel to abort the return address edit screen.



WYSIWYG
What you see is what you get.    Displays the text as it will be printed on the envelope or 
label if your system has a matching screen font.



Note Text
A note or attention line to be printed on the bottom left of the envelope or large label.

Select from a variety of descriptive notes by clicking the Note Text combo box arrow, or 
enter text of your choice in the Note Text box that appears in the lower right corner of the 
envelope screen.

Items that appear in the note text list may be easily deleted or added to.    Click the 
Maintain Note Text List selection of the Options menu.    To delete items, select and 
highlight the items to be deleted and click the Remove button.

The printed position of the note text can be either below the addressee text or below the 
return address text.    From the Maintain Note Text dialog box, select Print Position to change
the default selection.



Legal & Warranties
MAURER ASSOCIATES MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY 
DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE.    The customer's sole remedies are set forth in the warranty clause 
above.    Maurer Associates liability for damages shall not exceed the current registration 
fee for the product.    In no event will Maurer Associates be liable for any special, incidental 
or consequential damages even if Maurer Associates has been advised of the possibility of 
the same.



User Support & Assistance
Technical support is available for registered users and to those who desire to register 
PrintEnvelope.

Normal hours for support are Monday through Friday, 8:00 AM to 5:00 PM CST.

Phone: (214)432-0700

Fax: (214)506-0670

 Internet: maurer1@ibm.net ( preferred E-Mail address)

CompuServe: 74017,2140
Prodigy: HFJG92A
America Online: Smaurer

Mail: Maurer Associates
7324 Native Oak Drive
Irving    TX    75063-8405

The above address and telephone numbers are valid as of May 1, 1995 but may have 
changed by the time you view this document.    If you can not contact Maurer Associates at 
the above number or your mail is returned, attempt to make contact via the Email 
addresses.    If all fails, Maurer Associates is a member of the Association of Shareware 
Professionals.    Contact the Association offices for current information on Maurer 
Associates.

Association of Shareware Professionals
545 Grover Road

Musegon, MI 49442-9427
Fax (616)788-2765              CompuServe Mail    70007,3536.



PIM
Personal Information Manager such as Current, Desktop Set, etc.



Select
To mark an item by highlighting it with key combinations or by clicking it with the mouse.    
Selecting does not initiate an action.    After selecting an item you need perform an action 
such as copying to the ClipBoard.



Return Address Graphics
A bitmap created with PaintBrush or other drawing program, may be incorporated into your
return address.    The bitmap, if used in conjunction with a text return address, will display 
your company's logo to the left of the return address or, if No Return Address is selected 
from the Return Address menu, the bitmap can serve as the entire return address.    
Currently, graphics will not print properly if a Postscript printer driver is the active printer in
Windows.

Sample bitmaps are included with PrintEnvelope.    Face.bmp and Flag.bmp are logos 
designed be used with a text return address while the other samples are designed to serve 
as the entire return address.    These sample bitmaps may also be used as a template in 
designing your own logos.    Load them into your drawing program, select and cut the 
contents, prepare your own design and save as a monochrome or 16 color BMP under a file 
name of your choice.

When designing bitmaps, set your image attributes to a size just large enough to hold your 
graphic.    Unused white space in the graphic will only extend the time necessary to print.    
Suggested size for logos is 50x50 pels (½ inch square) to a maximum of 400x100 pels (4x1
inch) for    full return address bitmaps.    Graphics larger than the maximum could print in 
the OCR read area of the address block of your envelope and cause the mail piece to be 
rejected by automated sorting equipment.    Thus, they can not be loaded into the return 
address area.

Logo Scanning Service Available



Logo Scanning Service
Camera ready art
The House of Scanning in Englewood, Colorado will be happy to prepare your logo or return 
address graphic, ready to be used in PrintEnvelope.    Camera ready Art or your Letterhead 
Stationary will be scanned, sized, edited and quality optimized for laser printing.    With your
order, please enclose $30.00 for the first logo and $20.00 for each additional logo and a 
preformatted floppy diskette.

Hand Drawings
If you do not have Camera ready Art or Stationary, send the House of Scanning a hand 
drawing of what you expect to be created.    Your drawing will be reduced to fit the 
maximum logo size of 4 inches wide by 1 inch high.    With your order, please enclose 
$50.00 for each logo to be designed and a preformatted floppy diskette.

File Format Compatibility
All files delivered may be used in WordPerfect for Windows, Microsoft Word for Windows, 
Aldus Pagemaker, Ventura Publisher and a variety of other Windows Software.    Most 
Windows software packages allow you to manipulate the image, i.e. enlarge, reduce, rotate,
etc.    Please note that the printing quality will be drastically reduced if the image is 
enlarged.    For a nominal rate, the House of Scanning will provide you with a full size image
file and/or conversations to a variety of Image File formats.

Shipping
All orders are processed within 5-10 days and shipped to you via First Class mail.    For 24 
hour priority service and shipping please call.

Other Services
The House of Scanning offers many other Scanning, Imaging, Design, Art and Publishing 
Services.    Contact them at:

House of Scanning, Ltd.
7609 East Jamison Drive
Englewood, CO    80112

Fax: (303)771-0250 Phone: (303)771-4853



Command Line Switches
When calling PrintEnvelope from a word processor with a macro or from a run command 
line, you can use optional switches to automate certain functions when the program first 
starts.    The switches and their usage are:

/P - Paste the contents of Windows Clipboard into the addressee box.

/Q - Paste the contents of the Clipboard and print the envelope or label using 
PrintEnvelopes default document size, return address and fonts.

/E - Exit PrintEnvelope when the current envelope or label is printed and return to the 
previous Windows application.

/M - Use this switch to Minimize PrintEnvelope when started from the strratup group.

The command line switches may be used alone or in combination with other switches.    As 
an example:    envelope /qe will start PrintEnvelope, paste the contents of the Clipboard 
into the addressee box, print the envelope and exit back to the previous task.



PostNet bar coding
When the Use PostNet box is checked for the selected document size, PrintEnvelope will 
print USPS approved POSTNET bar codes in the new 11 digit DPBC (Delivery Point Bar Code)
format on your envelope or label.    The option to print bar codes can be toggled on or off 
during the session by double-clicking the PostNet is ON/OFF status bar on the bottom of 
the envelope.
The printing position of the bar code is preset to above the addressee text in the newly 
implemented "address block" area.    Although you often see PostNet bar codes aligned on 
the bottom right area of the mailing piece, placement above the address text is a more 
reliable printing area for most printers and also allows PostNet bar codes to be printed on 
labels.    
Initially, the default is to print only 11 digit ZIP+4 DPBC barcodes.    Five digit zip codes may
be bar encoded but do not qualify for postal rate reductions.    To print five digit codes, click 
File and select Preferences... to set the way barcodes are printed.    Never add -0000 to a 
five digit code to make it a ZIP+4.
If you have altered the print position of your addressee text to other than PrintEnvelopes 
defaults, make sure that the printed PostNet bar code is within the acceptable printing 
region.    This region is within 1 inch from each side edge of the envelope, no lower than 5/8
inch from the bottom edge of the envelope and no higher than 2 3/4 inches from the 
bottom edge of the envelope.    Dot matrix printer users should have their print resolution 
set to the higher setting available.    PostNet bar codes should print crisply to assure an 
accurate read by Postal Service sorting equipment.    If your bar codes do not show good 
contrast between the bars and white space, you may need to change your ribbon or adjust 
the contrast on a laser printer.    If you are using PostNet bar codes on labels, the label must
be affixed squarely upon the envelope as a skew of more than 5% to the bottom edge will 
cause a misread by the Postal Service sorting equipment.

Why use PostNet bar codes?    Application of bar codes will usually speed your mail through 
the Postal Service sorting process since mail bearing a PostNet bar code will normally 
bypass the OCR and go directly to the bar code sorter.    Volume mailers using DPBC bar 
codes also enjoy the benefit of reduced mailing costs.    Check with you local Post Office for 
complete details.



Importing a Mail List
A Windows Cardfile, dBase file or an ASCII delimited file may be imported and printed to 
either envelopes or labels.    Select Import -Print Mail List file from the Address Book 
menu.    The file open dialog defaults to .CRD for card files, .DBF for dBase files and .ADR for
ASCII files.    Select one or more records from the list box to print.    The addresses selected 
will be continuously printed to the envelopes or labels as selected in the Document menu.   
If you need to manually feed envelopes or label sheets into the printer, check the "Pause to
feed printer" box.    While printing, if PrintEnvelope encounters a questionable address, you 
will be prompted to verify its correctness.

Printing from a Windows Cardfile:    When printing a card file, PrintEnvelope will select all 
text up to the first blank line as the address.    When creating your card file, make sure that 
the address information is first on the card and that a blank line separates the address 
information from other data on the card.    If the first line of text on your card begins with a 
"(" or a numeral, then PrintEnvelope will assume that the line is a telephone number and 
will begin printing with the second line of text.

Printing from an ASCII delimited file:    An ASCII delimited file must be created with each 
field in the record enclosed by quotation marks and separated by a comma.    A typical 
record would look like : "Mr. Henry Jones","XYZ Company","123 Main 
Street","Anywhere USA 12345-6789"    Each record in the file must have the same 
number of fields and each field in the record will be printed so don't include items such as 
phone numbers, etc.    Empty fields ("Mr. Henry Jones","","123 Main 
Street","Anywhere USA 12345-6789") are ignored and will not print.

Printing from a dBase file:    When you first open a dBase file, you will be presented with a 
dialog box from which to select the appropriate records to use.    First select a field to use in
the list box for selecting individual records.    Click the small "Copy ->" button to place the 
field name in the "Field to select records" box.    Next, "build" the addressee text by 
selecting individual records and "copying" them to the "Fields for addressee information" 
box.    Use the "Add Space" and "Next Line" buttons to format the addressee fields with 
spaces and linefeeds.    Once satisfied, click Save to retain the format layout for future 
sessions. 

Using Postal Permit Imprints



Positioning Printed Text
By default, PrintEnvelope positions the return address in the upper left hand corner of the 
envelope or large label.    Addressee text is positioned, depending on the envelope size, a 
value from the left edge and 3/4" from the bottom edge of an envelope.    If your return 
address or addressee text is printing too far to the right by 1 1/4 inch, changing the Feed 
option should correct the situation.    Small labels, by default, center the text on the label.

If you are using envelopes or large labels with pre-printed return address information, use 
the positioning feature to align your department number, name or mail drop to the pre-
printed text.    The positioning feature may also be used to change the position of the 
addressee text.
To set print positions, first choose the document size and print an envelope or label with the
default settings.    Calculate the amounts to offset, both horizontally and vertically, for each 
of the return address and addressee text in inches.    Click Document, click Set selected 
document preferences and enter the calculated offsets in the appropriate areas of the 
dialog box.
Note that positive horizontal values move the text to the right.    Positive vertical values for 
the return address move the return address text down while positive vertical values for the 
addressee move the text up towards the top of the envelope or label.
The offsets you select will be saved for the active document size.
When changing the print positions for envelope sizes, use caution to conform with Postal 
Service regulations.    The bottom edge of the return address should be no lower than 2 3/4"
from the bottom edge of the mail piece.    The addressee text should be positioned a 
minimum of 1" from each side edge and 5/8" from the bottom edge of the mail piece.



Postal Permit Imprints
The permit imprint is a popular method of postal payment used by many first-class, thrid-
class, bulk-rate and non profit organizations.    Application must be made to the post office 
for a permit number, check with your local post office for details.

To imprint a postal permit on your envelopes, Click the stamp in the upper right hand 
corner of PrintEnvelope.    Edit the information displayed to conform with the information 
required by your individual permit.    When leaving the edit box, if changes have been made
you will be prompted to save the changes for future use.

To turn the permit imprint printing off, click the Close Permit Imprint button beneath the 
permit edit box..



ZIP Code look-up city/state name

You can have PrintEnvelope automatically insert the city and state name into your envelope
for printing.    Just enter a five or nine digit ZIP Code as the last address line and click Print. 
Alternatively, you may click the envelope or press the Alt Z key combination to have the 
city/state entered before committing to print the envelope or label.
The shareware version of PrintEnvelope does not have a complete database present due to 
distribution size limitations.    Up to 5 ZIP Codes and their corresponding city and state 
names may be added to the sample database provided.    Click Options...| Maintain ZIP 
Code database to add new records.
The registered version of PrintEnvelope, as a bonus, has a database of over 46,000 ZIP 
Codes, City and State names ready for use with the program.    When the full database is 
available, the file ZIPADDTL.DBF is searched first.    This allows for the addition of ZIP Codes 
with Local city names rather than the Official Name Place designated by the Postal Service. 




